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ONE manual

The ONE module was born out of a desire to bring the entire world of sampled sound into the 
modular system with a tight coupling to the beat. ONE combines the great audio quality of 24 
bit and 96kHz �les with high performance and ease of use.  SD card media provides access to an 
unlimited palette of sounds from user created WAV �les or commercially available cards crafted 
only for ONE. Each SD card can hold up to 256 sound �les in 16/24bit mono WAV format. Files 
can range in length from under a second to over an hour long.
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Getting started:

One is very simple to use. Install it in your system and insert the SD card with the VCTRS label 
facing the button side then power up.  Plug the audio out of ONE to your audio system or set 
ONE on the same bus board as your MIXZ to have the output automatically routed to the MIXZ. 
Set level half way up, set the white pitch knob half way up, click on the PLAY button to hear the 
�rst sample play o� the card. If you insert the card after power up you will need to click the 
button twice, once for telling ONE to load the card and second to trigger the sound. Now con-
nect a trigger out from your Circadian Rhythms, Trigger Riot or other sequencer into the GATE 
IN, you should hear ONE triggered by the sequencer. Turn the yellow knob to switch sounds. 
Turn the white knob to change pitch.



Patch Tutorial 1

Turn the white pitch knob to minimum, now connect the CV out from the Z8000 or other 
sequencer into the CV IN, clock the Z8000 and listen how the Z8000 sequences the sample 
pitch. 
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CV Modes:

ONE has three modes for processing external CV. 

1) Quantized Pitch. This is the default setting on ONE.  CV select playback rates which corre-
spond to the 12 tone equal temperament Western scale.  The CV input is not 1V/Oct but since 
internal it already get quantized to pitch there is no need to use a Quantizer. The range is 
approximately 3.5 octaves and the native rate of the �le determines how far up and down the 
�le can be pitched.  See section on sample rate and pitch for more on that. Naturally as the pitch 
lowers the attack part of the sound gets longer which results in delaying the initial part of the 
sound.

2) Free Pitch.  In this mode playback rate is not quantized but covers a similar playback rate 
range (3.5 octaves) with �ner resolution between rates.  Same as above, as the pitch gets lower 
the attack part of the sound gets longer and the onset of the sound is delayed.

3) File Select. In this mode di�erent �les can be loaded with CV, CV points to a �le in the card 
and a trigger pulse loads it. The �le will play at the native rate of the sample.  The CV in gets 
added to an o�set created by the FILE select yellow knob.  For example, if you select the 10th 
�le using the FILE knob, the CV will select a range of 32 samples upwards from 10. Because 
changes apply only with a trigger a new level of CV can be set during the �le playback without 
a�ecting the currently playing sound and the next trigger will activate it.  Note that latency 
increases in this mode due to the access time needed for the SD card to �nd and load the �le 
when changed. Please note that ONE performs a lot of operations in a short time to maintain 
minimal latency, a slow sequencer with unsynchronized Trigger/CV timing might not work well 
in this mode. We recommend the Z8000 with Circadian Rhythms or Trigger Riot for a reliable use 
of this mode.

Selecting CV Modes:  

Remove any CV source connected to the CV in Jack and follow these steps:

- Hold the PLAY button down (best done with no �le playing)
- Turn the white knob side to side, you will notice how the light switch from red to blue to  
 �ashing red, each one indicate a di�erent mode. Upon releasing the button at a given   
 light state will load that corespondent mode:

Solid RED - Free Pitch
Solid Blue - Quantized Pitch
Flashing Red - File Switching



Trigger/Gate/Fade/Loop modes:

ONE has four modes for handling a variety of audio material. 

Trigger Mode - This is the default mode for ONE with the lowest latency and is highly recom-
mended for use with percussive sequenced sounds. ONE detects the rising edge of a trigger 
and starts playing from the start of the �le until the end.  If a new trigger pulse is detected ONE 
will stop the currently playing sound and retrigger.  

Fade Mode - similar to Trigger Mode only with a fade in/out at the trigger point to remove any 
clicks from audio discontinuities.  This mode is most useful with smooth sounds that have a low 
content of high frequency harmonics where the ‘click’ is more obvious and distracting if not 
removed. Due to the nature of the fade process some latency is added to retriggering.

Gate Mode - ONE starts playing when a gate pulse comes in and only plays as long as the gate 
is high. This mode is good for processing very long samples that do not require tight timing. The 
audio is faded in and out to remove clicks. Note that the fade out takes at least 10ms (at 96k) 
and increases as the sample rate slows down - if the fade does not complete before the next 
trigger a click may still be heard.

Looping Mode - by pushing the PLAY button or sending a single trigger ONE will start playing a 
continuous loop.  Re-triggers reset to the start of the audio �le.  Looping can be stopped by 
selecting a new �le with the yellow knob. In addition to drum and sequencer loops this mode is 
great for turning ONE into a CV generator with LFO, noise or other waveforms.

Selecting Trigger/Gate/Fade/Loop modes: 

Remove any CV source connected to the CV in Jack and follow these steps:

- Hold the PLAY button down (best done with no �le playing)
- Turn the FILE yellow knob step by step, you will notice how the light switch from red to  
 blue to �ashing red to �ashing blue, each one indicate a di�erent mode. Upon releasing  
 the button at a given light state will load that corespondent mode:

- Solid Red -  Trigger mode
- Solid Blue - Gate mode
- Flashing Blue - Fade mode
- Flashing Red -  Looping mode



SD cards and your own samples:

You can use ONE with your own samples or with the sample libraries available for ONE from 
various  sound designers. The VCTRS library that come with ONE is made by Glicthmachines and 
can give you a taste of whats out there. 

ONE relies heavily on the performance of the SD card and not all SD cards on the market work 
well. We had tested cards from SanDisk, Kingston, Fuji, Lexar, with mostly good results. Some 
other cards like Samsung and Apacer failed testing which results drops, pops and digital noise.

ONE comes with an SD card that had been tested. You can use this card with the supplied adap-
ter as a start to add more samples to the VCTRS sample library it contain. You can also copy the 
VCTRS �les to your computer, delete them from the card and load the card with other �les and 
whenever you need the VCTRS samples just drop them back to the card.

Notes about WAV �le compatibility:

The WAV �le is not technically an audio speci�c but rather a RIFF format that can contain many 
additional elements like metadata, tempo info, images, video and even blank sections.  ONE 
attempts to skip these sections and �nd the audio data, but in some cases there will be too 
much additional data or the structure of the WAV results in poor real-time performance and the 
�le is not loaded.

To ensure maximum compatibility we recommend using the editor Audacity to export WAV 
�les before moving them to a card. (The following steps are not mandatory, you can skip to File 
Info and just make sure the �les are compatible)    

Here is how to use Audacity to prepare your samples:

Download the free software Audacity

http://www.audacityteam.org

Open Audacity, go to ->

File -> Edit Chains  

Add - > Type “ONE” -> ok

Insert -> Stereo to Mono

Insert -> ExportWave



Close this window

Now Audacity is ready to process your �le.

Go to->

File -> Apply Chains -> ONE 

Apply to Files -> select all the �les you want to process -> OK

Audacity will convert and clean your �les one by one and save them in a folder called Cleaned 
located inside the folder with the original samples. (The only downside of using Audacity for 
this purpose is that the default bit rate is 16bit so even if your original �les are 24bit Audacity 
will convert them to 16bit)

The next step is to rename the �les. On a Mac highlight all the samples, right click and select 
Rename, follow this set up:



All �les will now be numbered like:

File1.wav
File2.wav
File3.wav

(Windows has similar rename batch process, please google to search for an online example.)

Copy up to 256 �les and drop them into the SD card. Load in to ONE and you should be ready 
to play them.

File Info:

ONE plays any mono WAV format �le with a bit depth of 16 or 24 bits and a sample rate from 8 
to 96 kHz.  The native rates supported by ONE are 44.1, 48, 88.2 and 96 kHz and these can be cor-
rectly quantized to the Western 12 tone scale.  Other rates will use 48k as their time base and be 
pitched up or down accordingly.

The �le names can be any alphanumeric character (A-Z, 0-9) but are limited to 13 characters in 
length and the 13 characters includes the .wav extension.  

ONE scans the microSD card for all compatible �les on power up and makes a table of the �les.  
ONE can store a maximum of 256 �les in the table.  



After formatting your card should be ready to have �les copied to it.

Formatting the SD card:

The SD card must be in a speci�c format for the ONE module to read:

- SDHC not high speed cards for video
- 32GB or less.  Smaller cards usually perform better than larger
- FAT32 (or MS-DOS as it is called on the Mac)
- Master Boot Record (MBR) 

Most SD cards come already formatted this way from the factory. If you need to reformat the 
card please follow these steps:

On a Mac, insert the SD card to your computer open Utilities - > Disk Utilities 

Select Erase, set up the following settings:



Swapping SD cards:

ONE can handle removing SD cards during playback.  To swap cards, remove the SD card, insert 
a new one and then either send a Trigger to ONE or press the PLAY button.  The LED will �ash 
Red indicating ONE is loading the new library.

When no card is inserted the LED slowly �ashes Blue.  

Please note that cards need to be removed and inserted �rmly, and partial insertion might con-
fuse the detecting circuit and cause an error.

Sample Rate and Pitch:

ONE can play back �les using a set of quantized sample rates to give a 12 tone Western scale.  
The native sample rate of the �le determines the range of the pitch up or down.  

 Sample Rate Upward Pitch     Downward Pitch
 48k                   +12(octave)       -30 (2.5 octaves)
 96k                     0                         -42 (3.5 octaves)
 

ONE changes the sample rate of the playback rate to the audio DAC so there is no interpolation 
of the sample data.  This type of playback lowers the pitch as the rate slows just like a tape ma-
chine.  At lower sample rates some aliasing noise may emerge at the higher frequencies depen-
ding on the audio �le source.

ONE has two types of pitched playback - Quantized and Free.  Quantized uses sample rate chan-
ges that correspond the the Western 12 tone scale.  So if you load a sample of an acoustic instru-
ment playing the note C4 at 48kHz, the playback range will be from about F1 to C5.



VCTRS and Commercial SD Cards:

ONE includes a card called VCTRS featuring 60 carefully chosen sounds from the 5 sound banks 
developed by Glitchmachines.  We have included some of the most compelling material from 
each bank in order to showcase ONE’s strengths and demonstrate the broad range of sounds 
available on the PERC, SBSTRT, KERNL, HYBRD and BENT cards which are available separately 
from Eurorack retailers.

VCTRS and the other Glitchmachines cards include the entire sound set sampled at 48kHz, 64 
kHz and 96kHz.  The 48k rate allows for easy pitching up of one octave, 64k o�ers some pitch 
upward while maintaining much of the �delity of the 96k source and full 96k o�ers the purity of 
the source as well as the lowest latency possible for great performance.

Forthcoming cards from a wide array of sound designers, artists and producers will expand the 
range to include poly and mono synth tones, �eld recordings and even CV source material.

Custom Boot Options:

Some users might want ONE to boot up each card in a speci�c mode to match the material on 
it. A con�guration �le can be added to the SD card that tells ONE how it needs to boot up.

When ONE mounts any SD card it checks for a �le called con�g.txt that contains data about how 
to set up functions for Trigger/Gate/Fade/Loop mode and CV mode.  This is a basic text �le that 
can be edited with any basic text editor on your computer. The �le needs to be saved as .txt, not 
.rtf or .doc.  with the following simple format:

- First line is a comment beginning with #
- Second line sets the Trigger Mode: Trigger, Gate, Looping and Fade are options
- Third line sets the CV mode: Free, Quantized or Select File
- Lines after this are ignored but can contain notes or comments

Note it is important to use an uppercase letter for the �rst letter in the settings.

# Example con�g.txt for ONE
Trigger
Quantize
#
# Anything after this is ignored
#
# format:
# �rst line is comment
# second line is Trigger type - Trigger, Gate, Loop or Fade 
# third line is CV type - Select File, Quantize, Free
# parameters must have capital �rst letter!



Firmware Update:

ONE loads �rmware o� the SD card for easy updates.

- Unzip the �rmware �le if needed
- Copy the �le image.hex to the SD card
- Power down the case
- Insert SD card into ONE
- Hold the button down on ONE
- Power on the case
- The button light will �ash rapidly while loading the new �rmware code
- ONE then boots normally

LED Indicators and Errors:

ONE uses the dual color LEDs to give feedback on the internal states of mounting and reading 
the SD card.

Flashing Red LED  ONE is scanning the SD card for compatible �les during boot

Flashing Blue LED  ONE has not detected an SD card.  Insert a compatible one.

During the boot sequence the SD card scanning can take a few moments if there are hundreds 
of �les to check.  After it is complete the LED alternates Blue and Red before turning o� indica-
ting ONE booted successfully.

MixBus Jumper:

The back circuit board has a ‘MixBus’ jumper (J13) which can route the output of the module to 
the same audio bus located on the power distribution board.  This is the same bus used by 
Tiptop drum modules and the MixZ module can mix this audio with up to 8 other sources 
patched through the front panel.



Speci�cations:

- SDHC microSD card up to 32GB in size
- FAT32 �le system
- WAV �le format
- 16 or 24 bit depth
- Minimum sample rate 8kHz
- Maximum sample rate 96 kHz
- Latency (Pitch CV and Trigger Modes) at 48 kHz ~0.5ms 
- Latency (Pitch CV and Trigger Modes) at 96 kHz ~ 0.25ms
- Dynamic Range 104 dB
- THD+N 0.0025%

- 4 HP
- 43mm deep

- +12V@80ma
- -12V@8ma
- +5V@0ma
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